IDEXX Cornerstone*
Up and Running With the Electronic Whiteboard
8.3 *Participant Workbook*
Up and Running with the Electronic Whiteboard

Table of Contents

Introduction ......................................................................................................................... 4
Course Description ............................................................................................................. 4
Prerequisites ....................................................................................................................... 4
Getting Started .................................................................................................................. 4
Training Content ................................................................................................................. 4

Electronic Whiteboard Setup, Usage, and Reports

Electronic Whiteboard Setup .......................................................................................... 6
  Customizing the Electronic Whiteboard ........................................................................ 6
  Electronic Whiteboard Nonbillable Invoice Item Setup ............................................. 12
  Dispensing Items ......................................................................................................... 13
  Reason for Visit .......................................................................................................... 15
  Secondary Reason for Visit ....................................................................................... 15
  Reason for Visit Display ............................................................................................. 16
  Electronic Whiteboard Default Settings .................................................................... 17
  Electronic Whiteboard Security Settings .................................................................. 19

Electronic Whiteboard Usage ......................................................................................... 21
  Patient Check-in .......................................................................................................... 21
  Create and Finalize Estimates ................................................................................... 22
  Patient Orders ............................................................................................................ 24
  Patient Orders and Electronic Whiteboard Patient Visit List .................................. 30
  Diagnostic Test Results ............................................................................................. 36
  Patient Treatments ..................................................................................................... 37

Electronic Whiteboard Reports ....................................................................................... 43

Appendix

  Travel Sheets ............................................................................................................... 46
  Creating Smart Groups ............................................................................................... 48
  Electronic Whiteboard Setup and Usage Quick Reference Guide ............................... 50

Skill Assessment and Evaluation

  Up and Running With the Electronic Whiteboard Skill Assessment .......................... 57
  Up and Running With the Electronic Whiteboard Evaluation .................................... 58
Introduction

COURSE DESCRIPTION

Following review of setup completion, key project leaders who are moving their practice towards becoming chartless or trying to improve efficiencies will learn how to use Cornerstone’s powerful Electronic Whiteboard capabilities within their real data files. This includes demonstrating how to use the practice’s customized Whiteboard to enable rollout to the staff.

PREREQUISITES

- The current version of the IDEXX Cornerstone* Practice Management System installed at the practice.
- Basic Cornerstone software navigation skills.
- Security access for setting up Cornerstone software features related to the Electronic Whiteboard.
- Basic knowledge of how to set up invoice items, departing instructions, and prescription instructions in the Cornerstone software.

GETTING STARTED

Throughout this training, you will be working in your own practice’s database.

This course is most effective if you work at a Cornerstone workstation while following along in the participant workbook and completing the exercises.

TRAINING CONTENT

Content of the course includes:

- Electronic Whiteboard Setup and Work Flow
- Patient Orders and Whiteboard Patient Visit List
- Patient Treatments
- Electronic Whiteboard Reports

These icons are used throughout the training to provide additional information:

- **Important Information**: Provides critical information about the topic or procedure. Read this information carefully.
- **Note**: Provides additional information about the topic or procedure.
- **Tip**: Provides helpful information about the topic or procedure.

When you see this image placed below a lesson name, it indicates that video snippets are available online at idexxlearningcenter.com for topics related to this lesson.
Electronic Whiteboard Setup, Usage, and Reports
Electronic Whiteboard Setup

You’ll learn these important concepts in this chapter:

- **Customizing the Electronic Whiteboard**—View and adjust various defaults and setups that improve the effectiveness of using the Electronic Whiteboard window in your practice. Customize alerts, categories, areas, frequencies, patient hospital statuses, and wards/locations to make it easy for your staff to use the Whiteboard.

- **Electronic Whiteboard Nonbillable Invoice Item Setup**—Create nonbillable invoice items for the Electronic Whiteboard and set the rules for Whiteboard use.

- **Dispensing Items**—Create and attach multiple dispensing fees to an inventory item. Link a dispensing item to an invoice item.

- **Reason for Visit**—Verify and create reasons for visit.

- **Secondary Reason for Visit**—Verify and create secondary reasons for visit.

- **Reason for Visit Display**—Set up reasons for visit with color codes to customize the display of reasons for visit.

- **Default Settings**—Set Electronic Whiteboard default settings.

- **Security Settings**—Set Electronic Whiteboard security settings.

**CUSTOMIZING THE ELECTRONIC WHITEBOARD**

Your staff’s effectiveness when using the Electronic Whiteboard is affected by proper setup. In this section, ensure you have completed the recommended setup in your Cornerstone software.

**Alerts**

Create Electronic Whiteboard alerts using:

- User-defined prompts
- Classifications
- Preset Electronic Whiteboard alerts
- User-entered Electronic Whiteboard alerts (must be less than 30 characters)

**Setup:**

- Update existing alerts (user-defined prompts, classifications)
  - You can designate certain patient prompts (Controls > User Defined Prompts > Patient tab) to display on the Electronic Whiteboard window.
• You can designate certain patient classifications ([Controls > Classifications > Patient] tab) to display on the Electronic Whiteboard window.

• Create Electronic Whiteboard alerts ([Lists > Electronic Whiteboard > Alerts])

Examples:
- NPO
- Surgery today
- Brought own meds
- Liquid diet only
- In heat
- Brought own food
- Monitor incision
- Chews bandages

Areas
- Customize areas so that you can, for example, view lab work the technicians have for the day using the main Electronic Whiteboard window.

- Select [Lists > Electronic Whiteboard > Areas] to open the Treatment Area List window.

Areas
(Areas assigned per Electronic Whiteboard order)

<table>
<thead>
<tr>
<th>Setup Suggestions</th>
<th>Boarding ICU Treatment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locations or Department in Hospital</td>
<td>Tasks List</td>
</tr>
<tr>
<td>Tasks List</td>
<td>Staff to Complete</td>
</tr>
<tr>
<td>Staff to Complete</td>
<td>Use Options</td>
</tr>
</tbody>
</table>

Use Options
- Filter Electronic Whiteboard main view and Electronic Whiteboard reports.
- Assign to each patient order.
Categories

- Use categories to:
  - Assign per patient order
  - View patient treatments
  - Filter Electronic Whiteboard reports and Whiteboard treatments view
- Select **Lists > Electronic Whiteboard > Categories** to open the Treatment Category List window.
  - Customize categories so that the Patient Treatments window has a general order that works for your medical team.
- The following treatment categories are already set up for you in the Cornerstone software:
  - Vital Signs
  - Medications
  - Diagnostics
  - Daily Care
  - Treatments
  - Communication/Discharge
Frequencies

- Select Lists > Electronic Whiteboard > Frequencies to open the Treatment Frequency List window.
- Make frequency changes so that:
  - Practice hours and treatment times are reflected in the provided frequencies already set up in your database.
  - You can treat every hour, every other hour, every day, every x days, start today with the same time tomorrow, and start today with a different time tomorrow.
  - Patient Visit List charges will be calculated properly (billing type x frequency = Patient Visit List charge).

- Customize to fit practice hours and needs.
  **Example:** every day vs. every x day
- Modify frequency description to include time.
  **Example:** BID 8a, 5p; every two hours (even)
- Set order of frequency drop-down list. A list of default frequencies is provided below.

<table>
<thead>
<tr>
<th>Nonrecurring</th>
<th>Recurring (24-hour based)</th>
<th>Recurring (set to clinic preferences)</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Time</td>
<td>Every 4 hours</td>
<td>SID</td>
</tr>
<tr>
<td>Until Completed(^\d)</td>
<td>Every 6 hours</td>
<td>BID</td>
</tr>
<tr>
<td></td>
<td>Every 8 hours</td>
<td>TID</td>
</tr>
<tr>
<td></td>
<td>Every 12 hours</td>
<td>QID</td>
</tr>
<tr>
<td></td>
<td>Every 24 hours</td>
<td>Every 2 days</td>
</tr>
<tr>
<td></td>
<td>Continuous(^\d)</td>
<td>Every 3 days</td>
</tr>
</tbody>
</table>

\(^\d\)These frequencies do not include an “overdue” notification.

**Recommended Additional Electronic Whiteboard Frequencies**

<table>
<thead>
<tr>
<th>SID Noon</th>
<th>Every 2 hours (even)</th>
<th>Hourly</th>
</tr>
</thead>
<tbody>
<tr>
<td>SID PM</td>
<td>Every 2 hours (odd)</td>
<td></td>
</tr>
</tbody>
</table>
Patient Hospital Status

- Select **Lists > Patient Hospital Status** to open the Patient Hospital Status List window.
- Customize patient hospital statuses so that, at a glance, any staff member can see the current status.

![Patient Hospital Status List](image)

Additional statuses will be treated as “ready to go home” if the following keywords are included in the description: `home`, `discharge`, `release`, or `pick`.

Ward/Location

- Select **Lists > Ward/Loc** to open the Ward/Loc List window.
- Customize wards/locations so that you can filter by the number of patients in certain areas of the practice on the main Electronic Whiteboard window.

![Ward/Loc List](image)
### Ward/Loc
*(Wards/Locations assigned per patient)*

<table>
<thead>
<tr>
<th>Setup Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location in Hospital</td>
</tr>
<tr>
<td>Sx, Tx, Iso, ICU</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setup Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
</tr>
<tr>
<td>Boarding, Hospital, Grooming</td>
</tr>
</tbody>
</table>

### Use Options
- Sort or filter Electronic Whiteboard main view and Electronic Whiteboard reports.
- Enter or modify from Check-In and Patient Orders windows.
- Readily visible from Census List and Patient Clipboard* windows.

---

The table below shows how areas and wards/locations are related and how they can be used together. Both areas and wards/locations are filters for the main Electronic Whiteboard window.

#### Electronic Whiteboard Settings—Areas and Ward/Loc

<table>
<thead>
<tr>
<th>Areas (assigned per order)</th>
<th>Ward/Loc (assigned per patient)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setup Suggestions</strong></td>
<td><strong>Setup Suggestions</strong></td>
</tr>
<tr>
<td>Location in Hospital</td>
<td>Location in Hospital</td>
</tr>
<tr>
<td>Boarding, ICU, Treatment</td>
<td>Sx, Tx, Iso, ICU</td>
</tr>
<tr>
<td>Task List</td>
<td>Department</td>
</tr>
<tr>
<td>Lab Work, Radiology, Exam</td>
<td>Boarding, Hospital, Grooming</td>
</tr>
<tr>
<td>Staff to Complete</td>
<td>Reason for Visit</td>
</tr>
<tr>
<td>Tech, Doctor, Assistant</td>
<td>Board, Surgery, Drop Off</td>
</tr>
</tbody>
</table>

### Use Options
- Filter Whiteboard main view and Whiteboard reports.
- Assign to each patient order.
- Enter/modify from Check-In and Patient Orders windows.
- Readily visible from the Census List and Patient Clipboard windows.
**Electronic Whiteboard Nonbillable Invoice Item Setup**

An efficient way to use the Electronic Whiteboard is to designate certain Whiteboard groups to be used within this powerful feature. This makes the patient order entry process quick and facilitates adding nonbillable items to the Whiteboard by creating invoice items for use on the Electronic Whiteboard that will not be part of client invoice.

To set up nonbillable Whiteboard items:

1. Create a specific classification for the nonbillable items (Lists > Invoice Item Class). This will help the set up of pick lists and travel sheets in the future, as well as mass setup of default values.

2. Using the following examples as a guide, create invoice items under the Electronic Whiteboard classification created in step one. As these items will be nonbillable, there is no need to set pricing, link instructions, or add reminders or special actions.

   Select the **Miscellaneous** check box to allow customized descriptions when using on the Patient Orders window.

<table>
<thead>
<tr>
<th>Whiteboard Nonbillable Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administer Medication</td>
</tr>
<tr>
<td>Blood Draw</td>
</tr>
<tr>
<td>Call Client</td>
</tr>
<tr>
<td>Remove Catheter</td>
</tr>
<tr>
<td>Check Bandage</td>
</tr>
<tr>
<td>Check Stool</td>
</tr>
<tr>
<td>Check for Vomiting</td>
</tr>
<tr>
<td>Check Incision</td>
</tr>
<tr>
<td>Feed</td>
</tr>
<tr>
<td>Feed (Owner Food)</td>
</tr>
</tbody>
</table>

3. Click the **Whiteboard** tab. Set default values and field-level rules for the invoice items that staff may enter on the Patient Orders window. Refer to the following image on the next page for available fields.

   ![Tip Image](image.png)

   **Tip** The Invoice Item Setup tool (Tools > Invoice Item Setup) is used to set up your invoice items for the first time or to quickly make mass changes to many invoice items simultaneously. The Whiteboard tab allows you to perform a mass setup of default values and field-level rules for invoice items that staff may enter on the Patient Orders window.
See the Cornerstone Help system for more information on using the Invoice Item Setup tool.

For increased efficiency in using Electronic Whiteboard non-billable invoice items, consider using a smart group or travel sheet. Please see the Appendix for the setup information for these features.

**DISPENSING ITEMS**

Dispensing items are a type of invoice item, and while they may not be used by themselves, they are attached to an inventory invoice item record. Dispensing items can be useful if your practice has different methods for dispensing items.

**To add a dispensing item (for example, prescribed rather than administered medications):**

1. On the menu bar, select **Lists > Invoice Item**.
2. Click **New**.
3. In the **ID** box, accept the system-generated ID or type an ID.
4. Select **Dispensing** as the item type.
5. In the **Hospital description** box, type a description. The description appears in the Invoice Item List window, in reports, and in a pop-up window where you can select the dispensing item from a list when attached to an inventory item.
6. Optional: In the **Default revenue center** area, type the revenue center ID to be used by default for this item, or double-click or press F2 to select the revenue center from a list. Dispensing items are a type of invoice item, but they cannot be used alone. They must be linked to an inventory invoice item to be used.
7. From the **Status** list, select the status of this item.
8. In the **Dispensing fee** area, select one of the following options:
   - **Amount**—Type the fee in the box.
   - **Percent of inventory price**—Type the percent of the inventory price to use for the fee.
9. If appropriate for this dispensing item, select the **Override the inventory price and apply only the dispensing item fee** check box.
10. Click the **Instructions** tab.
11. If it is appropriate to link departing instructions to this item, double-click or press F2 in the first ID box and select the departing instructions from a list. Repeat for each instruction to link. Departing instructions print on invoices and are listed in the patient’s medical history.

   To review your list of departing instructions, select Lists > Departing Instructions or Reports > Invoice Item > Departing Instructions.

12. Select the Tax/Disc tab.

13. Select any sales taxes, usage taxes, and discounts to apply to the dispensing item.

14. When the information regarding the setup of this dispensing item is complete, click OK to save it.

15. Click Close to exit.

**Link a Dispensing Item to an Invoice Item**

Link a dispensing item to an invoice item so that the dispensing fee is linked to the invoice item but is a separate item.

**To link a dispensing item to an invoice item:**

1. On the menu bar, select Lists > Invoice Item.
2. Select the invoice item and click Update or double-click the item.
3. On the Info tab, click the Dispensing button.
4. Select the dispensing item(s).
5. Optional: If you want to allow staff to select from a list of all active dispensing items, select the Allow All check box.
6. Click OK to save the information.
7. Click OK to exit.

   Existing dispensing fees should be removed from items that have linked dispensing items so that clients are not double billed for the dispensing fee.

   **Tip**

   You can mass update dispensing fees and dispensing items with the mass markup tool (Tools > Mass Markup). Mass markup requires exclusive use (the computer you are using must be the only one logged into the Cornerstone* system).
**REASON FOR VISIT**

Reasons for visit are covered during the defaults phase of your training with a decision maker. At the time of completing the Appointment Scheduler setup, it is likely that the reasons for visit selections will already be set up.

**To add or update a reason for visit:**

1. On the menu bar, select Controls > Reason for Visit.
2. In the Primary reason for visit area, click New to add a new primary reason or double-click an existing reason to update it. The New/Update Primary Reason window opens.
3. In the Description box, type a name for the reason for visit.
4. Optional: In the Alert note box, type a note that will appear as an alert when this reason for visit is selected.
5. Optional: In the Patient check-in/out documents area, link a document to print when the patient is checked in or out. If the icon to the left of the Doc ID column has a yellow arrow pointing to the right, the document prints at check-in. If a green arrow points to the left, the document prints at checkout.
6. Click OK, and then click Close.

**SECONDARY REASON FOR VISIT**

The reason for visit feature allows for both primary and secondary reasons for visit, allowing you to provide staff with more information on the patient's visit. Most commonly, the primary reason would be used to indicate the general type of visit, and the secondary reason would be used to provide more detail on the specific problem or procedure. For example, if the primary reason is Surgery, the secondary reason might be spay/neuter, hip replacement, cruciate, or orthopedic.

**To add or update a secondary reason for visit:**

1. On the menu bar, select Controls > Reason for Visit.
2. In the Secondary reason for visit area, click New to add a new secondary reason or double-click an existing reason to update it.
3. In the **Add/Update Secondary Reason for Visit** box, type a brief identifying name for this secondary reason (for example, cruciate, glucose curve, or foreign body ingestion).

4. Click **OK**, and then click **Close**.

   - The primary and secondary reasons for visit are not associated with each other in the software.

   - **tip** To avoid staff having to select from a long list of secondary reasons, you may want to set up a predefined list with only the most common secondary reasons and instruct staff to type other secondary reasons as needed. A secondary reason can be typed on the fly at the time of use, but the primary reason must be selected from your predefined list.

   - The secondary reason for visit shows clearly on the Electronic Whiteboard main view, along with the color dot for the primary reason for visit.

**REASON FOR VISIT DISPLAY**

Colors display on the Appointment Scheduler window and on templates based on the reason for visit selected when the appointment was set up.

**tip** Using different colors for your reasons for visit will make the schedule easy to read at a glance. The primary reason for visit color will appear on the Electronic Whiteboard main view.

To customize the reason for visit display:

1. On the menu bar, select **Controls > Appointment Scheduler > Reason for Visit**. Select the reason for visit and click **Update**.

2. On the Reason for Visit window, set the following parameters:

   - **Appt color**—To use a different color, double-click the existing color or click **Set Color**. Select a color and click **OK**.

   - **Performed by**—Select the staff member who usually performs this type of appointment.

   - **Number of units**—Enter the default number of time units for how long this type of appointment usually takes.

   - **Dr/Asst Time**—Select the check boxes for the number of time units needed to perform the service. For example, a recheck appointment may be scheduled to take 20 minutes, but the doctor will be with the patient for only 10 minutes. These time units appear on the Schedule for Today window with an X next to the selected time slots, indicating that a staff member is scheduled to attend to the patient during that time period. You can select check boxes without assigning a staff member to the reason for visit.

3. Click **OK** to save the reason for visit information.
## Electronic Whiteboard Default Settings

On the menu, go to **Controls > Defaults > Practice & Workstation > Whiteboard** to set the default Electronic Whiteboard settings for your practice.

<table>
<thead>
<tr>
<th>Menu Access</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Whiteboard</strong>&lt;br&gt;See figure LL</td>
<td>Whiteboard auto refresh timer ____ Minutes</td>
<td>Enter a number (in minutes) for how often the Electronic Whiteboard should automatically refresh.</td>
</tr>
<tr>
<td></td>
<td>Length of time to keep discharged patients on Whiteboard ____ Hours</td>
<td>Enter the number of time (in hours) to keep patients on the Electronic Whiteboard.</td>
</tr>
<tr>
<td></td>
<td>Hours to show</td>
<td>Select one of the following options for how many hours to show on the Electronic Whiteboard:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Current day only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Current day with 3 hours for previous and next days</td>
</tr>
<tr>
<td></td>
<td>Doctor to use on invoice line</td>
<td>Select a default doctor to use on the invoice line. Options are Supervising Dr., Current Care Dr., or Who Performed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The supervising and current care doctors are determined at the time orders are written.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Performing staff is determined at the time items are marked completed.</td>
</tr>
<tr>
<td></td>
<td>Use doctor from Patient Visit List</td>
<td>Select this check box if you want the staff from the Patient Visit List invoice item lines to transfer as the doctor for the patient orders.</td>
</tr>
<tr>
<td></td>
<td>Invoice when patient is not at “Ready to go home” status</td>
<td>Determines under which circumstances a staff member is allowed to invoice a client for a patient who is still in the Not ready to go home status on the Electronic Whiteboard. Options are Allow, Manager Override, Stop, and Warn.</td>
</tr>
<tr>
<td></td>
<td>Allow invoice if uncompleted treatments</td>
<td>Determines under which circumstances a staff member is able to invoice a client when a patient has treatment on the Electronic Whiteboard that has not been marked complete. Options are Allow, Manager Override, Stop, and Warn.</td>
</tr>
<tr>
<td></td>
<td>Future hours to check for uncompleted treatments when invoicing ____ Hours</td>
<td>Enter the number of hours in the future to check for uncompleted treatments when invoicing.</td>
</tr>
</tbody>
</table>

---

**Figure LL**

(Controls > Defaults > Practice and Workstation > Whiteboard)
### Controls > Defaults > Practice and Workstation

<table>
<thead>
<tr>
<th>Menu Access</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workstation</strong> <em>(Defaults are set per workstation)</em></td>
<td>Print Patient pictures on</td>
<td>Select the client correspondence items on which to print the patient’s picture. The patient’s picture can print on the Boarding Check-in Report, Check-in Report, estimates, invoices, prescription labels, rabies certificates, and reminders.</td>
</tr>
<tr>
<td></td>
<td>Whiteboard sort</td>
<td>Select the method for sorting patients on the Electronic Whiteboard.</td>
</tr>
<tr>
<td></td>
<td>• Sort patients by</td>
<td></td>
</tr>
</tbody>
</table>

### Figure R

(Controls > Defaults > Practice and Workstation > Workstation)
**ELECTRONIC WHITEBOARD SECURITY SETTINGS**

On the **File** menu, select **Security Setup** and view security options for the Electronic Whiteboard.

<table>
<thead>
<tr>
<th>Cornerstone Window</th>
<th>Access Suggestions</th>
<th>Path to Locate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Hospital Status Information</td>
<td>GEN X REC DR TECH M/O X</td>
<td>Lists &gt; Patient Hospital Status</td>
</tr>
<tr>
<td>Patient Hospital Status List</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Patient Hospital Status</td>
</tr>
<tr>
<td>Ward/Loc Information</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Ward/Loc</td>
</tr>
<tr>
<td>Ward/Loc List</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Ward/Loc</td>
</tr>
<tr>
<td>Whiteboard</td>
<td>GEN X REC DR TECH M/O X</td>
<td>Activities &gt; Electronic Whiteboard &gt; Whiteboard</td>
</tr>
<tr>
<td>Whiteboard Alert List</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Electronic Whiteboard &gt; Alerts</td>
</tr>
<tr>
<td>Whiteboard Area Information</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Electronic Whiteboard &gt; Areas</td>
</tr>
<tr>
<td>Whiteboard Area List</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Electronic Whiteboard &gt; Areas</td>
</tr>
<tr>
<td>Whiteboard Category Information</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Electronic Whiteboard &gt; Categories</td>
</tr>
<tr>
<td>Whiteboard Category List</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Electronic Whiteboard &gt; Categories</td>
</tr>
<tr>
<td>Whiteboard Complete Task</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Electronic Whiteboard &gt; Categories</td>
</tr>
<tr>
<td>Whiteboard Frequency Information</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Electronic Whiteboard &gt; Frequencies</td>
</tr>
<tr>
<td>Whiteboard Frequency List</td>
<td>GEN X REC DR TECH</td>
<td>Lists &gt; Electronic Whiteboard &gt; Frequencies</td>
</tr>
<tr>
<td>Whiteboard Invoice Posting Override</td>
<td>GEN X REC DR TECH</td>
<td>Activities &gt; Invoice (message displays)</td>
</tr>
<tr>
<td>Whiteboard Orders Override Defaults</td>
<td>GEN X REC DR TECH</td>
<td>Controls &gt; Defaults &gt; Practice and Workstation</td>
</tr>
<tr>
<td>Whiteboard Orders Override Frequency</td>
<td>GEN X REC DR TECH</td>
<td>Controls &gt; Defaults &gt; Practice and Workstation</td>
</tr>
<tr>
<td>Whiteboard Patient Orders</td>
<td>GEN X REC DR TECH</td>
<td>Activities &gt; Electronic Whiteboard &gt; Patient Orders</td>
</tr>
<tr>
<td>Whiteboard Patient Treatments</td>
<td>GEN X REC DR TECH</td>
<td>Activities &gt; Electronic Whiteboard</td>
</tr>
<tr>
<td>Whiteboard Patient Visit List (PVL)</td>
<td>GEN X REC DR TECH</td>
<td>Patient Clipboard &gt; Select Client &gt; Right-click</td>
</tr>
<tr>
<td>Whiteboard Remove Patient</td>
<td>GEN X REC DR TECH</td>
<td>Whiteboard &gt; Right-click patient &gt; Remove from Whiteboard</td>
</tr>
<tr>
<td>Whiteboard Undo Treatment</td>
<td>GEN X REC DR TECH</td>
<td>Patient Clipboard &gt; Select Client &gt; Right-click</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Foundation Reports Security</th>
<th>Access Suggestions</th>
<th>Path to Locate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whiteboard Patient Orders Report</td>
<td>GEN X REC DR TECH M/O X</td>
<td>Reports &gt; Patient &gt; Whiteboard Patient Orders Report</td>
</tr>
<tr>
<td>Whiteboard Patient Treatments</td>
<td>GEN X REC DR TECH</td>
<td>Reports &gt; Patient &gt; Whiteboard Patient Treatments</td>
</tr>
</tbody>
</table>

1Exclusive to Multi-Location Inventory
2Exclusive to Multi-Practice
3Indicates a report that is available for multi-location databases
4Security setting for a purchasable module

This document contains suggested security settings for General Login (GEN), Receptionists (REC), Technicians (TECH), Doctors (DR), and Managers/Owners (M/O). However, it is ultimately the practice’s decision-maker that decides who needs access to certain areas within Cornerstone®, and IDEXX shall not be liable for any actions arising from those security decisions.
Chapter Summary

You learned these important concepts in this chapter:

- **Customizing the Electronic Whiteboard**—View and adjust various defaults and setups that improve the effectiveness of using the Electronic Whiteboard window in your practice. Customize alerts, categories, areas, frequencies, patient hospital statuses, and wards/locations to make it easy for your staff to use the Whiteboard.

- **Electronic Whiteboard Nonbillable Invoice Item Setup**—Create nonbillable invoice items for the Electronic Whiteboard and set the rules for Whiteboard use.

- **Dispensing Items**—Create and attach multiple dispensing fees to an inventory item. Link a dispensing item to an invoice item.

- **Reason for Visit**—Verify and create reasons for visit.

- **Secondary Reason for Visit**—Verify and create secondary reasons for visit.

- **Reason for Visit Display**—Set up reasons for visit with color codes to customize the display of reasons for visit.

- **Default Settings**—Set Electronic Whiteboard default settings.

- **Security Settings**—Set Electronic Whiteboard security settings.
You’ll learn these important concepts in this chapter:

- **Patient Check-in**—Learn how to add patients to the Electronic Whiteboard window.
- **Create and Finalize Estimates**—Learn how to create and finalize estimates.
- **Electronic Whiteboard**—Learn about the features and benefits of the Electronic Whiteboard window, including the basic Whiteboard work flow, and how the Whiteboard fits into the equation of automating charges.
- **Patient Orders and Whiteboard Patient Visit List**—Learn how to enter patient orders by adding invoice items and smart groups and by transferring charges from the Whiteboard patient visit list.
- **Diagnostic Test Results**—Decide if you want to use the Electronic Whiteboard for handling diagnostic requests.
- **Patient Treatments**—View and navigate the main Electronic Whiteboard window. Perform other tasks such as updating patient orders and viewing a Patient Treatment Report, viewing detailed patient treatment information, entering vital signs and completing treatments, and discontinuing treatments and removing them from the Whiteboard.

## PATIENT CHECK-IN

There are two ways to add patients to the Electronic Whiteboard:

- **Check-in**—Patients can be added to the Electronic Whiteboard during the check-in process by selecting the **Inpatient** option on the Check-in window. Inpatient should only be selected only for patients that are being dropped off by the owner. The types of visits placed on the Electronic Whiteboard vary by practice but may include drop-offs, procedures, baths, and grooming.
- **Schedule Patient Orders**—Patients that were checked in as outpatients during the check-in process will be added to the Electronic Whiteboard when patient orders are scheduled in the Patient Orders window. This would happen in the common event that a sick patient is admitted to the practice after seeing a doctor in an exam room.
CREATE AND FINALIZE ESTIMATES

Creating Estimates

1. With the patient selected in the Patient Clipboard* window, right-click the patient and select **Estimate**.
2. In the **Estimate #** box, press **TAB**.
3. In the **Description** box, type a description for the estimate. This description does not print on the estimate but is used in the list of estimates for this patient and in patient history when the estimate is electronically signed. **tip** Add the initials of the person creating the estimate in case there are any questions.
4. Tab to the first **Item ID** field in the grid. Items can be added using the following methods:
   - To add an individual item, double-click or press F2, and then search the Invoice Item List by description.
   - Use a smart group (e.g., dental group).
   - Click **Travel Sheet** to select items from one or more travel sheets.
5. Update the estimate details (quantity, price, etc.) as needed.

<table>
<thead>
<tr>
<th>DENTAL GROUP</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>EXAMINATION</td>
<td>1.00</td>
<td>1.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>14</td>
<td>H</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>PRESH</td>
<td>1.00</td>
<td>1.00</td>
<td>$156.38</td>
<td>$156.38</td>
<td>14</td>
<td>H</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>IM CATHETER</td>
<td>1.00</td>
<td>1.00</td>
<td>$20.00</td>
<td>$20.00</td>
<td>14</td>
<td>H</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>IM PUMP</td>
<td>1.00</td>
<td>1.00</td>
<td>$7.00</td>
<td>$7.00</td>
<td>14</td>
<td>H</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>ANESTHESIA</td>
<td>1.00</td>
<td>1.00</td>
<td>$90.00</td>
<td>$90.00</td>
<td>14</td>
<td>H</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Dental Grade 2 Canine</td>
<td>1.00</td>
<td>1.00</td>
<td>$61.00</td>
<td>$61.00</td>
<td>14</td>
<td>H</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>PROPHY POLISH</td>
<td>1.00</td>
<td>1.00</td>
<td>$25.00</td>
<td>$25.00</td>
<td>14</td>
<td>H</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>FLUORIDE TREATMENT</td>
<td>1.00</td>
<td>1.00</td>
<td>$7.00</td>
<td>$7.00</td>
<td>14</td>
<td>H</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Antibio 150 mg (Clindamycin)</td>
<td>14.00</td>
<td>29.00</td>
<td>$38.00</td>
<td>$38.00</td>
<td>14</td>
<td>H</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

6. Click **OK** to save the estimate when the information is complete.
7. In the **Save Estimate** window, the following options are available:
   - **Preview/Signature**
   - **Save and continue**
     - **Print estimate**—Select this check box to print the estimate.
     - **Copies**—Enter the number of copies to print.
     - **Message**—Select a message to print on the estimate. You can change a message and select additional messages.
     - **E-Mail estimate**—Select this check box to print the estimate.
     - **Save estimate for ___ days**—Edit the number of days the estimate remains in the system until being closed by the end of day process. The estimate expiration date prints on the estimate. Unsigned estimates are no longer stored after this date. Signed estimates are stored until you purge them.
     - **Finalize estimate**—Select this check box to manually finalize the estimate.
8. Click **Options** to change the transfer and print options, and then click **OK**. You must have appropriate security to access the options.
   - Selections in the **Transfer to patient visit list** area determine the prices that transfer.
   - Selections in the **Print prices** area determine the prices that will print on the estimate.
   - Selections in the **Print** area determine both detailed item lines and the final total or only the final total prints.

9. In the Save Estimate window, click **OK**.

10. Based on your practice’s estimate default settings, you may be prompted to transfer items to the Patient Visit List. Click **Yes** to transfer the items.

    † This process places the items from the estimate onto the Patient Visit List (PVL). Later you will transfer items from the PVL to the Patient Orders window.

11. On the Special Actions window, click **Continue**; special actions will be completed at a later time.

**Finalizing Estimates**

1. With the patient selected in the Patient Clipboard* window, click the **Estimates** tab.
2. Double-click the estimate to update.
3. In the **Estimate #** box, press TAB. The estimate information appears.
4. Click **Finalize**.
5. In the Save Estimate window, make any necessary changes and click **OK**.
**PATIENT ORDERS**

**Electronic Whiteboard (Main Grid) Window**

The Electronic Whiteboard window provides a centralized view of patients’ treatment schedules and statuses. Also known as the “main grid,” this window acts as a key entry point to ordering and editing treatments. The Whiteboard allows quick access to important patient information at a glance, while also offering more detailed information on scheduled treatments and flexible date/time viewing options.

Practices that integrate the Whiteboard into their practice find it to be:

- A quick way to prescribe a treatment or follow a treatment protocol.
- A highly visible, easy way for staff to track and record patient care.
- An improved method to automate billing and capture charges based on provided care.
- A convenient location to record detailed care information into the medical record.

**Patient Column Sort Options**

The **Sort** list allows you to sort the Whiteboard Patients column by:

- Patient Name
- Client Name
- Reason for Visit
• Check-in Date/Time
• Doctor
• Hospital Status
• Treatments for Current Hour
• Treatments for Next Hour

Patients flagged as critical display at the top of the **Patients** column on the Whiteboard regardless of the selected sort order, with the exception of the Treatments for Current Hour/Next Hour sort orders, where critical patients display at the top only if they have treatments for that hour.

The sort order defaults to Patient Name unless a different default sort option has been specified in workstation defaults (set up workstation defaults at Controls > Defaults > Practice and Workstation > Workstation).

**Go to Now Button**

Click the **Go to Now** button to quickly reset the grid to the current day and hour.

**Show and Edit Whiteboard Filters**

The **Showing** area at the top of the window displays all currently selected filters, with an **Edit** button that allows you to access the Whiteboard Filter options.

The **Practice** list is available only for practices using the multi-location single database feature.

**Patients Column**

The **Patients** column to the left of the grid displays any patient marked as an inpatient upon check in. The patient information blocks in the **Patients** column provide an at-a-glance view of important patient information.
### Patient Column Features

<table>
<thead>
<tr>
<th>Description</th>
<th>Color-coded patient name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color coding of the patient name helps to identify the status of the patient or the status of the patient’s treatment orders.</td>
<td><strong>Yellow</strong>—Indicates the patient does not have any treatment orders assigned OR is on the Whiteboard past the expected discharge date.</td>
</tr>
<tr>
<td></td>
<td><strong>Red</strong>—Indicates the patient has overdue treatment orders.</td>
</tr>
<tr>
<td></td>
<td><strong>Black</strong>—Indicates the patient’s treatments are up to date.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Primary and secondary reasons for visit</th>
</tr>
</thead>
<tbody>
<tr>
<td>The color-coded dot indicates the primary reason for visit and the adjacent bold text provides the secondary reason. If a secondary reason is not assigned, the primary reason text displays.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Critical icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the patient has been flagged as critical on the Patient Orders window or during check-in, the <strong>Critical</strong> icon displays next to the patient status.</td>
<td></td>
</tr>
</tbody>
</table>

* The number shown in parentheses at the top of the Patients column indicates the current number of patients on the Whiteboard (note that any currently selected filters may affect the number shown).

### Additional Patient Information

To view additional patient information, rest the mouse pointer on a patient block. A pop-up window displays patient order information pertaining to the visit and includes the pet’s picture (if one is included in the patient record).

<table>
<thead>
<tr>
<th>Oreo (2517)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cope: 4</td>
</tr>
<tr>
<td>Feline</td>
</tr>
<tr>
<td>Shorthair, Domestic</td>
</tr>
<tr>
<td>14 Yrs. 5 Mos.</td>
</tr>
</tbody>
</table>

**Reason for visit:** Internal Medicine

**Secondary reason for visit:** PU/PD workup

**Date admitted:** 7/7/2011

**Expected discharge date:** 7/11/2011

**Supervising doctor:** Corin Schulze, DVM

**Current care doctor:** Corin Schulze, DVM
**Detailed Patient Treatment Blocks**

Patient treatment blocks include detailed information on each treatment scheduled for the time block, as well as a new pop-up window that provides an even greater level of detail.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Popup window provides details on all treatments for the hour</strong></td>
<td>If more than three treatments are scheduled for a patient during the hour, a down arrow▼ displays in the block to indicate there are more treatments to view. Rest the mouse pointer on the treatment block to view a popup window providing the list of treatments scheduled to be performed for the patient in this time slot. The popup window lists treatments broken out into groupings of Overdue (always displayed at the top), To Do, Completed, and Did Not Perform.</td>
</tr>
<tr>
<td><strong>Check mark displays next to completed treatments</strong></td>
<td>In both the treatment block and the popup window, a check mark ✓ displays next to any completed treatments.</td>
</tr>
</tbody>
</table>
| **Color coding indicates status of each treatment line within a block** | Color coding indicates the status of each treatment line:  
  - Green □ = Completed  
  - Bright blue ◆ = Scheduled  
  - Light blue ◆◆ = Continuous or Until Completed  
  - Red □□ = Overdue  
  - Gray □□□ = Discontinued or Did not perform |
| **Order of treatment lines within a block based on numbering of left column on Patient Orders window** | The treatment lines listed within a block are ordered according to the numbering of the invoice items in the left-most column on the Patient Orders window.                                                      |
**Alerts Column**

The **Alerts** column on the Electronic Whiteboard window allows you to add, edit, and view selected types of patient alerts.

Depending on your setup, the **Alerts** column may display the following types of alerts:

- Alerts from the Whiteboard Alerts List
- Patient prompt alerts
- Patient classification alerts
- Alerts manually entered on the Patient Check-in/out window
- Alerts manually entered on the Whiteboard window

† If more than three alerts exist for a patient, a down arrow displays in the block to indicate there are more alerts to view. Rest the mouse pointer on the alert block to view the patient’s full alert. You can manually enter alerts to display in the **Alerts** column for the patient on the Whiteboard window. You can also change the order of the alerts as they are listed in the **Alerts** block, remove an alert so it does not display in the block, and edit a manually entered alert.

**Electronic Whiteboard Work Flow Overview**

The IDEXX Cornerstone™ Practice Management System’s Electronic Whiteboard work flow (see image below) works in this manner: Add invoice items and smart groups on the **Patient Orders** window, possibly transferring in treatments from finalized estimates or other sources found on a Whiteboard patient visit list, and then go back to the **Patient Orders** window to complete the details. After initial orders are entered, staff monitor the main Whiteboard hourly grid to identify when treatments are to be completed, then double-click the treatment to open the **Patient Treatments** window to complete the treatment and record any detail care information. The end result is the recorded detailed care information with staff, time, and applicable charge.
Automating Charges

Before we get started in the Patient Orders window, it’s important to understand how the Electronic Whiteboard fits into the equation of automating and capturing charges. When you select quantities, billing, and frequencies on the Patient Orders window, it affects the charges that flow to the Patient Visit List. Referring to the illustration below, charges are entered as you complete treatments, and you manage the billing of those final charges on the Patient Visit List, along with other charge types. Notice the way that the arrows flow—some flow in one direction and some are bidirectional.
Patient Orders and Electronic Whiteboard Patient Visit List

Beginning the Patient Orders

In this activity, you’ll locate your test patient on the Electronic Whiteboard and enter the patient orders.

1. On the Patient Clipboard* window, select the patient, right-click, and select Electronic Whiteboard > Patient Orders.

You can access patient orders from the Patient Clipboard (shown below left), as well as from the main Whiteboard window (below right).

Patient Orders—Header

This table explains the key header information and how to best use the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient ID</td>
<td>Indicates which patient’s orders are being scheduled. Depending on how you accessed the Patient Orders window, the patient may already be selected. If not, in the Patient ID field, type the patient ID, or double-click or press F2 to search for and select the patient from the Patient List. With the patient ID specified, the patient’s name, client name, client ID, age weight, and body score (if activated), species, breed, and sex information displays.</td>
</tr>
<tr>
<td>Vital Signs/Weight button</td>
<td>Allows you to access the Vital Signs window to update weight and/or other vital signs for the patient. The button displays in red/yellow as an alert if at least one vital sign (other than weight and body score) has not been entered for the patient within the past 10 days.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates the patient’s standing in the hospital. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Inpatient—Patient is currently being treated.</td>
</tr>
<tr>
<td></td>
<td>• Ready to go home—Patient’s treatments are completed.</td>
</tr>
<tr>
<td></td>
<td>• Discharged—Client has been invoiced and the patient has been checked out of the hospital (or was manually removed from the Whiteboard).</td>
</tr>
<tr>
<td></td>
<td>• Any custom status that has been set up for the hospital.</td>
</tr>
<tr>
<td></td>
<td>A custom status will be considered equal to the “Ready to go home” status only if it contains one of the following keywords: Ready, Home, Pick, Release, or Discharge.</td>
</tr>
</tbody>
</table>
### Critical
Select this check box if you want to flag a patient as critical and display the **Critical** icon 🚨 for the patient on all Electronic Whiteboard windows, the Check-in/out window and the Census List window.

Patients flagged as critical display at the top of the **Patients** column on the Whiteboard, regardless of the selected sort order, with the exception of the Treatments for Current Hour/Next Hour sort orders, where critical patients display at the top only if they have treatments for that hour.

### Primary Reason for Visit
The general type of problem or procedure requiring the patient to be hospitalized (e.g., Dental, Emergency, Surgery).

Depending on the color assigned to this reason during setup (in **Controls > Appointment Scheduler > Reason for Visit**), a color-coded circle appears with the patient information on the Whiteboard and Patient Treatments window to indicate the reason for visit.

### Secondary Reason for Visit
The Secondary reason for visit can be used to indicate the specific problem or procedure requiring the patient to be hospitalized (e.g., Extraction, Vomiting, Spay). If a secondary reason for visit is specified, it displays with the patient information on the Whiteboard and Patient Treatment windows.

> A primary reason must first be specified to activate the secondary reason field. The secondary reason can then be selected from the predefined drop-down list, or staff can manually enter a different secondary reason.

### Admit date/time
Indicates when the patient is admitted to the hospital.

### Discharge date
Indicates when the patient is scheduled to leave the hospital. (By default, the Cornerstone system inserts the date three days after the admit date; you can change the discharge date once it is inserted. You cannot change the system setting.)

- Recurring treatments (e.g., BID) follow the patient discharge date unless ordered for a specific duration other than the discharge date.

### Supervising Doctor
The doctor who admits the patient and is the overriding decision maker for the case.

### Current Care Doctor
The doctor who assumes care of the patient if there is a shift change or if the supervising doctor is unavailable. Based on the practice default Whiteboard settings, charges from the Whiteboard are assigned to supervising doctor, current care doctor, or the doctor who performed the treatment.

### Cage
Specific cage or location where the patient will be located while hospitalized.

### Ward
General location where the patient will be staying while hospitalized.

> *tip* This can also be used as a Whiteboard filter.

### Alert
Indicates any Whiteboard-specific patient alerts.

---

2. Update this information as needed:
   - **Patient ID, Patient Name, and Client ID**
   - **Patient Status**
     - Optional: Select the **Critical** check box to flag a patient as critical and display the **Critical** icon 🚨.
     - Primary and Secondary Reasons for Visit. The primary and secondary reasons for visit are listed (if they were previously selected). A primary reason must first be specified in order to activate the secondary reason field.

3. Optional: Accept or modify the information in the **Admit Date** and **Admit Time** boxes.

4. Optional: Accept or modify the date in the **Discharge Date** box.

5. In the **Supervising** and **Current Care** boxes, enter the staff IDs for the appropriate doctors.
6. In the Cage box, type the cage information. This is typically used to add a cage number and other information.
7. From the Ward list, select the ward.

**Patient Orders—Body**

Enter your invoice items and groups. Keep in mind the information in the table below.

- If a smart group or invoice item has been previously added to the Patient Orders window, the information "memorized" from the last time that the invoice item or group was used will automatically appear.

<table>
<thead>
<tr>
<th>Quantity</th>
<th>The quantity for the treatment.</th>
</tr>
</thead>
</table>
| **Billing** | Billing choices affect the number of times an item is added to the Patient Visit List | **Examples of billing choices:**
| Billing Type† | Frequency | Number of Days | Quantity Charged** | Total Invoice Lines |
| 1 Line Each Time | BID | 2 | 4 | 4 |
| 1 Line Each Day | BID | 2 | 4 | 2 |
| 1 Line Each Visit | BID | 2 | 4 | 1 |
| No Billing or Inventory Reduction | BID | 2 | 0 | 0 |

†Each day/visit options are for service type items only.
**The quantity charged to the patient.

<table>
<thead>
<tr>
<th>Category</th>
<th>The category selection affects how the treatment line displays in the Patient Treatments column on the Whiteboard.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Frequency</strong></td>
<td>How often the treatment should be performed. Many commonly used frequencies are provided, including:</td>
</tr>
<tr>
<td>Continuous</td>
<td>Treatment is continued until the end of the specified duration occurs, the treatment is discontinued, or the patient is checked out. Continuous treatment time blocks display with a light blue background on the Whiteboard.</td>
</tr>
<tr>
<td>If continuous frequency is used on a billable item, the patient visit list is charged with every instance of a completed treatment.</td>
<td></td>
</tr>
<tr>
<td>Until Completed</td>
<td>Used when a time for completion cannot be assigned based on the type of action or treatment (e.g., staff needs to obtain a urine sample). When this option is selected, Until Completed displays on the Whiteboard until the item is processed once. Then, the treatment will be marked Completed at the time staff processes the order.</td>
</tr>
<tr>
<td>One time</td>
<td>Treatment is added for the start date and time indicated on the order.</td>
</tr>
<tr>
<td>Every __ hours</td>
<td>Treatment is added for the start date and time listed on the order and for every number of hours indicated until the discharge date.</td>
</tr>
<tr>
<td>Every __ days</td>
<td>Treatment is added for the start date and time listed on the order and for every number of days indicated until the discharge date.</td>
</tr>
<tr>
<td>An overdue notice is not applicable to Continuous and Until Completed frequencies.</td>
<td></td>
</tr>
<tr>
<td>One Time and Every __ hours/days frequencies display an overdue notice once the scheduled time is past.</td>
<td></td>
</tr>
</tbody>
</table>

| **Note** | Used to indicate whether an additional Whiteboard medical note entry is required when the selected treatment is marked as Completed or Did not perform. The default note includes a date/time stamp and the staff member who performed the treatment. |
| **Vital Signs** | Select this check box for items requiring the staff to check and record vital signs. |
### Electronic Whiteboard Usage

<table>
<thead>
<tr>
<th><strong>PRN</strong></th>
<th>Select this check box for treatments as needed. Used in addition to preset time frequency types (e.g., BID, TID). Treatments will not be listed as overdue.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dose Now</strong></td>
<td>For treatments to be performed once immediately; then follow regularly scheduled frequency. Used in addition to preset time type frequencies (e.g., BID, TID).</td>
</tr>
<tr>
<td><strong>Start Date/Time Duration</strong></td>
<td>Affects initial start and how long you’ll see the treatment on the Whiteboard. Used in addition to frequency. Start date and time default to current day and hour. Duration can be set in days/hours if it will differ from the discharge date. Often used in conjunction with the continuous frequency.</td>
</tr>
<tr>
<td><strong>Blue Line</strong></td>
<td>Use the blue line to enter such information as fluid type and fluid drip rates. The information entered on the blue line as special orders is saved to the patient’s electronic medical record when your staff completes the treatment.</td>
</tr>
<tr>
<td><strong>Area</strong></td>
<td>OPTIONAL: Select an area that the patient order is for. Areas can be departments, tasks, or specific staff. This information can be used as a filter for the main Whiteboard view.</td>
</tr>
<tr>
<td><strong>Staff Classification</strong></td>
<td>OPTIONAL: Select a staff classification completing the treatment. This information can be used as a filter for the Whiteboard Treatment Report.</td>
</tr>
<tr>
<td><strong>Alerts</strong></td>
<td>If Whiteboard alerts exist for the patient, you can view and edit those alerts from the Patient Orders window. If there is more than one alert for the patient, a down arrow ▼ displays to the right of the Alerts field to indicate there are more alerts to view. Rest the mouse pointer on the displayed alert to view the patient’s full alert list in a pop-up window. To open the Whiteboard Alerts window to edit or add to the patient’s alert list, click the blue edit link located to the right of the Alerts field.</td>
</tr>
<tr>
<td><strong>Left Column for Numbering Patient Treatment Orders</strong></td>
<td>To specify the order in which treatments should display on the Whiteboard and Patient Treatments windows, renumber them as needed by changing the numbers in the left column. The order of treatments specified on the Patient Orders window is the order that will be used to display the treatment lines in the patient’s treatment block for each hour on the Whiteboard. To renumber a treatment order line, change the number in the left column and press TAB. For group items, you cannot change the order of the individual items until after the patient orders have been saved by clicking OK on the Patient Orders window. You can then reopen the window and reorder the individual items as desired.</td>
</tr>
<tr>
<td><strong>No Billing icon 🎨</strong></td>
<td>If an item’s Billing field is set to No billing or inventory reduction, the No Billing icon 🎨 displays in the blue line below the line item as a reminder to staff. This icon also appears on the Patient Treatments window for the order item. When the Patient Orders item is set to No billing or inventory reduction, the invoice item is not pulled from inventory and the client is not charged.</td>
</tr>
</tbody>
</table>
Schedule treatments using incremental (on-the-minute) time scheduling

You can specify a start time using incremental (on-the-minute) times (e.g., 10:15 AM, 2:30 PM). The incremental treatment times will show on the Patient Treatments window and the Whiteboard window.

If you want to enter orders for a treatment needing to be completed every ____ minutes within a single hour—for example, a glucose curve test every 10 minutes—you would need to add a separate treatment order line for each occurrence.

So for the glucose curve example, the orders would look like this on the Patient Orders window:

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/21/2011</td>
<td>09:15 AM</td>
<td>Glucose curve test</td>
</tr>
<tr>
<td>07/21/2011</td>
<td>09:20 AM</td>
<td>Glucose curve test</td>
</tr>
<tr>
<td>07/21/2011</td>
<td>09:25 AM</td>
<td>Glucose curve test</td>
</tr>
</tbody>
</table>

...and like this on the Whiteboard grid’s treatment block:

<table>
<thead>
<tr>
<th>9 am</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 glucose curve test</td>
</tr>
<tr>
<td>10 glucose curve test</td>
</tr>
<tr>
<td>10 glucose curve test</td>
</tr>
</tbody>
</table>

If an incremental time is specified, the treatment line turns red as overdue on the Whiteboard when that specific time passes (not at the end of the hour, as with nonincremental treatment times).

Additional items may also be added from:

- **Patient Visit List**—Click PVL, and then select the check boxes in the Ord column for the items to be added to patient orders. When the appropriate check boxes have been selected, click Order.
- **Travel Sheet**—Click Travel Sheet, and then select the travel sheet from which you’ll make selections. Make your selections and click Transfer for the items to be added to the patient orders. For more information, see “Travel Sheets” on page 46.

8. Click PVL.

   **Tip** Click the PVL button to access and transfer items into the Patient Orders window from the Whiteboard Patient Visit List.

9. View items to transfer to the Patient Orders window; scroll up to see the entire list.

10. Review and delete duplicate items as appropriate. (Duplicate items are displayed in a burgundy font.) To delete, select the item ID to be deleted and press CTRL + D.

11. Change the status of items as needed.

   Only items with a status of recommended or accepted can be transferred to the Patient Orders window.
12. In the **Ord** column, select the check boxes for the items you want to move from the Patient Visit List (PVL) window, appointment items, and the medical note to the Patient Orders window. Remember items that were placed on the PVL from appointment items, the medical note, and the finalized estimate. If appropriate, select the **Select All** check box to select all of the items on the PVL; you can deselect items if necessary. If items are already marked as “performed,” they cannot be transferred from the Whiteboard Patient Visit List to the Patient Orders window.

13. Click **Order**.

14. In the Patient Orders window, make any needed changes to the order details. See the sample below.

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Item Description</th>
<th>Quantity</th>
<th>Billing Category</th>
<th>Frequency</th>
<th>Note</th>
<th>PRN</th>
<th>Now</th>
<th>Doc</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>TSH</td>
<td>1.00</td>
<td>1 line each time</td>
<td>Diagnosis</td>
<td>Unit Complete</td>
<td>Not required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>P.A.</td>
<td>1.00</td>
<td>1 line each time</td>
<td>Diagnosis</td>
<td>Unit Complete</td>
<td>Not required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>I.V. Catheter Placement</td>
<td>2.00</td>
<td>1 line each time</td>
<td>Treatments</td>
<td>Unit Complete</td>
<td>Not required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>105</td>
<td>I.V. Set/Cath &amp; Fluids - 500ml</td>
<td>1.00</td>
<td>1 line each time</td>
<td>Treatments</td>
<td>Unit Complete</td>
<td>Not required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>108</td>
<td>IV Pump per day</td>
<td>2.00</td>
<td>1 line each time</td>
<td>Treatments</td>
<td>BID 1x per day</td>
<td>Not required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>109</td>
<td>Lactated Ringers</td>
<td>2.00</td>
<td>1 line each time</td>
<td>Medications</td>
<td>BID 1x per day</td>
<td>Not required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Cerenex Injectable</td>
<td>1.00</td>
<td>1 line each time</td>
<td>Medications</td>
<td>BID 2x per day</td>
<td>Not required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>111</td>
<td>Cerenex Injectable</td>
<td>1.00</td>
<td>1 line each time</td>
<td>Medications</td>
<td>BID 2x per day</td>
<td>Not required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>112</td>
<td>Hospitalization</td>
<td>2.00</td>
<td>1 line each time</td>
<td>Professional See/Every 24 hrs</td>
<td>Not required</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

15. Add other items to Patient Orders window as needed.
   - Double-click or press F2 in the next available **Item ID** field to add an invoice item or smart group.
   - Click **Travel Sheet** to add items from a travel sheet.

16. In the Patient Orders window, make any changes to the order details. This includes information in the **Billing Category**, **Frequency**, and **Note** columns.

17. Add blue line communications as needed.

18. Update patient orders information as needed. For example, select one or more of the **Vital Signs**, **PRN**, or **Dose Now** check boxes.

19. Update the **Start Date/Time** and **Duration** fields as needed. Assign an area to each patient order (based on your practice setup) to create an additional Whiteboard filter. Optional: Assign a staff classification for completing the treatment.

20. Click **OK** to save the patient order and close the Patient Orders window.

21. From the Patient Orders window, once you click **OK**, patient orders cannot be deleted but they can be discontinued.
Prescriptions

There are two ways to handle items with dispensing fees on the Whiteboard.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>You dose from a prescribed bottle</td>
<td>Create a prescription label for the medication from the Patient Clipboard* window or Patient Visit List window, or enter the medication in the Patient Orders to be completed one time. This bills the medication and creates the prescription label (if the prescription label special action is being used) when your staff completes the treatment. If your practice does not bill for giving medication, enter an order for a nonbillable service. If needed, use the blue line to communicate administration specifics. Set the frequency to how often the medication should be given.</td>
</tr>
<tr>
<td>You dose medication as needed from a common vial</td>
<td>In the Patient Orders window, enter the medication to be administered with the appropriate frequency. Dispensing items should also be created and attached to the appropriate inventory items to ensure your full dispensing fee will not be charged each time you administer the medication. Dispensing items allow the staff a choice on the dispensing fee that will be added to the medication price. Dispensing Item Examples: Meds To Go Home, Meds Admin In Hospital, etc.</td>
</tr>
</tbody>
</table>

Diagnostic Test Results

Decisions will need to be made for handling diagnostic requests with the use of the Electronic Whiteboard. Ask yourself the following question: Do I want to see if the diagnostic test has been completed on the Whiteboard?

Prerequisite: Invoice items must have appropriate diagnostic request special actions attached.

| YES                                                                 | 1. Finalize estimates and click **Continue** on the Special Actions window.  
|                                                                   | 2. Enter patient orders.  
|                                                                   | • Transfer diagnostic items from the Whiteboard PVL (Patient Visit List) to the Patient Orders window.  
|                                                                   | 3. Complete patient treatments.  
|                                                                   | • Select the **Process** button on the Special Actions window to send the diagnostic request to the IDEXX VetLab* Station or Imaging Dashboard or to generate the IDEXX LabREXX* test request form and show the diagnostic request as completed.  |
|                                                                   | **-OR-**  
|                                                                   | 1. Finalize estimates and click **Process** on the Special Actions window.  
|                                                                   | • This sends the diagnostic request to the IDEXX VetLab Station or Imaging Dashboard or generates the IDEXX LabREXX test request form.  
|                                                                   | 2. Enter Nonbillable Patient Orders for Diagnostic Request.  
|                                                                   | • Use the blue line to note which labs will be run, how much blood to draw, radiograph position, etc.  
|                                                                   | 3. Complete patient treatments.  |

| NO                                                                  | 1. Finalize estimates and select **Process** on the **Special Actions** window.  
|                                                                  | • This sends the diagnostic request to the IDEXX VetLab Station or Imaging Dashboard or generates the IDEXX LabREXX test request form.  
|                                                                  | 2. This lab charge will be found on the Patient Visit List and will not need to be transferred to the Whiteboard.  |
**PATIENT TREATMENTS**

The Electronic Whiteboard window is a highly visible and easy way for staff to view, track, and record patient care. You’ll learn how to view the main Whiteboard and record the completion of patient treatments—even several treatments at once (per patient).

**View and Navigate—Main Whiteboard Window**

Use the main Whiteboard window to view the entire Whiteboard patient list. The number of patients you can view depends on the orientation and resolution of the monitor and whether or not you are using a normal workstation monitor or a large Whiteboard monitor. The main Whiteboard listing displays in patient alphabetical order by default; however, patients marked as critical display at the top of the list.

1. Click the **Whiteboard** button on the toolbar.

<table>
<thead>
<tr>
<th>Patients (11)</th>
<th>8 am</th>
<th>8 am Now</th>
<th>9 am</th>
<th>10 am</th>
<th>11 am</th>
<th>Noon</th>
<th>1 pm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lila</td>
<td>Oxygen Therapy</td>
<td>Oxygen Therapy</td>
<td>Oxygen Therapy</td>
<td>Oxygen Therapy</td>
<td>Oxygen Therapy</td>
<td>Oxygen Therapy</td>
<td></td>
</tr>
<tr>
<td>Agnihotri(231)</td>
<td>IV Set/Cath &amp; Fluids</td>
<td>IV Set/Cath &amp; Fluids</td>
<td>IV Set/Cath &amp; Fluids</td>
<td>IV Set/Cath &amp; Fluids</td>
<td>IV Set/Cath &amp; Fluids</td>
<td>IV Set/Cath &amp; Fluids</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IV Pump per day</td>
<td>IV Pump per day</td>
<td>IV Pump per day</td>
<td>IV Pump per day</td>
<td>IV Pump per day</td>
<td>IV Pump per day</td>
<td></td>
</tr>
<tr>
<td>Wally</td>
<td>Oxygen Therapy</td>
<td>Oxygen Therapy</td>
<td>Oxygen Therapy</td>
<td>Oxygen Therapy</td>
<td>Oxygen Therapy</td>
<td>Oxygen Therapy</td>
<td></td>
</tr>
<tr>
<td>Ahmed(13)</td>
<td>IV Set/Cath &amp; Fluids</td>
<td>IV Set/Cath &amp; Fluids</td>
<td>IV Set/Cath &amp; Fluids</td>
<td>IV Set/Cath &amp; Fluids</td>
<td>IV Set/Cath &amp; Fluids</td>
<td>IV Set/Cath &amp; Fluids</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IV Pump per day</td>
<td>IV Pump per day</td>
<td>IV Pump per day</td>
<td>IV Pump per day</td>
<td>IV Pump per day</td>
<td>IV Pump per day</td>
<td></td>
</tr>
<tr>
<td>Barksalot</td>
<td>Medical Exam-Vent</td>
<td>Medical Exam-Vent</td>
<td>Medical Exam-Vent</td>
<td>Medical Exam-Vent</td>
<td>Medical Exam-Vent</td>
<td>Medical Exam-Vent</td>
<td></td>
</tr>
<tr>
<td>Brown(999)</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td></td>
</tr>
<tr>
<td></td>
<td>氧</td>
<td>氧</td>
<td>氧</td>
<td>氧</td>
<td>氧</td>
<td>氧</td>
<td></td>
</tr>
<tr>
<td>Callie</td>
<td>Exploratory Laparo</td>
<td>Exploratory Laparo</td>
<td>Exploratory Laparo</td>
<td>Exploratory Laparo</td>
<td>Exploratory Laparo</td>
<td>Exploratory Laparo</td>
<td></td>
</tr>
<tr>
<td>Delberg(178)</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td></td>
</tr>
<tr>
<td></td>
<td>探</td>
<td>探</td>
<td>探</td>
<td>探</td>
<td>探</td>
<td>探</td>
<td></td>
</tr>
<tr>
<td>Izzie</td>
<td>Zuniga(16)</td>
<td>Zuniga(16)</td>
<td>Zuniga(16)</td>
<td>Zuniga(16)</td>
<td>Zuniga(16)</td>
<td>Zuniga(16)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td>Inpatient</td>
<td></td>
</tr>
</tbody>
</table>

- Point to a patient in the grid to see the patient information box.
- Use the date filter to navigate to treatments for the previous day and next day.
- Click **Go to Now** to reset the grid to the current hour and day. The current hour column header displays in bold black text on a yellow background with **Now** appearing to the right of the hour.
- Select doctors, wards, and use the areas filter.
  - **Doctors**—Shows the number of doctor procedures based on current care doctor assigned per patient.
  - **Wards**—Shows the number of patients in a selected area.
  - **Areas**—Shows the number of laboratory tests that technicians needs to complete. You can show select tasks, department, or staff, based on how the area is set up.

Refer to the **Showing** area at the top of the window to view currently selected filters. Click **Edit** to open the Whiteboard Filter window.
• Learn the treatment codes and colors.
  
  Whiteboard colors cannot be modified.

<table>
<thead>
<tr>
<th>Treatment Code</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled</td>
<td>Bright Blue</td>
</tr>
<tr>
<td>Continuous and Until Completed</td>
<td>Light Blue</td>
</tr>
<tr>
<td>Completed</td>
<td>Green</td>
</tr>
<tr>
<td>Overdue</td>
<td>Red</td>
</tr>
<tr>
<td>Disc (Discontinued) and DNP (Did Not Perform)</td>
<td>Gray</td>
</tr>
</tbody>
</table>

Other Tasks—Update Patient Orders and View Patient Treatment Report

2. Right-click the patient and select Patient Orders.
3. Update patient orders as needed. For example, change the start time.
4. Click OK to close the Patient Orders window.
5. In the Whiteboard window, right-click the patient, and select View/Print Selected Day. The Whiteboard Treatment Report window opens.

To view all entered/modified orders for a patient, view the Whiteboard Patient Orders Report (Reports > Patient > Whiteboard Patient Orders Report). The report indicates “changed by” based on the user logged in at the workstation.
View Detailed Patient Treatment Information and Complete Treatments

After your patient orders or treatments are entered, the medical team can use the report we previewed to view treatments. The entry of completed treatments might occur in the following ways:

- Your technicians carry a tablet PC during treatments and complete them in Cornerstone in real time.
- Your technicians print a Patient Treatment Report from Cornerstone and attach to each cage.
- Using your practice’s own treatment sheets, the technicians complete the treatments, and then go to a workstation and mark all treatments as completed at the same time.

7. Close the report.
8. Open the Patient Treatments window by double-clicking the grid for the time/date slot for your selected patient.
9. To complete single treatments.
   a. In the grid, double-click in the box (cell) that represents the time and selected treatment you are documenting as complete.
   b. In the window that opens in the lower portion of the screen for completing a patient treatment, enter the staff ID of the person performing the treatment (this will be saved to patient history).
   c. Select Completed or Did not perform.
   d. Select Display using scheduled time or Display using completed time.
   e. Enter any additional Whiteboard medical notes.
f. Before you click **OK**, review the item pane for your treatment to ensure accurate staff billing. This can be manually updated as needed.

g. Click **Process** to process any designated special actions.

10. To complete multiple treatments at the same time, press SHIFT and select consecutive treatments or press CTRL and select nonconsecutive treatments.
   
a. Right-click and select **Process Selected Treatments**. Enter the completion details as appropriate.
   
   ![Double-click the Completed cell...](image)

   ![then click Undo](image)

   When completing multiple treatments, the staff ID is copied to all treatments and cannot be changed.

b. Click **OK** after completing the first treatment. The next treatment in the selected group will appear, copying all previous details. Click **OK** after each subsequent treatment until all are completed.

   ![You can undo a treatment you have marked as completed. Double-click the completed treatment and click Undo.](image)

   In the Undo Treatment window, enter the staff ID and a reason for change. This comment is saved to history and any associated charge on the Patient Visit List window is removed.

11. In the Patient Treatment window, enter vital signs for the patient in one of two ways:
   
   a. **Method 1** (vital signs action assigned from patient orders or a special action)—Double-click in a time slot area on the grid for a TPR, Take Vitals, or similar treatment, enter the treatment completion information and click **OK**. The Vital Signs window opens.
   
   ![Method 1](image)

   OR
   
   b. **Method 2**—Click the **Vital Signs** icon in the patient header of the treatment window to open the Vital Signs window. Then, click the **more vital signs** link.
   
   ![Method 2](image)

   a. Enter the vital signs and click **OK** to save the data set.

   b. Enter the staff ID, click **OK**, and close the Vital Signs window.

12. Complete additional treatments as needed.

13. Close the appropriate windows.
Discontinue Treatments and Remove from Whiteboard

Occasionally, you may have a treatment that is no longer valid. Some reasons might be that the doctor has received laboratory results and will take a different course of action, the treatment wasn’t needed, or the treatment was accidentally entered on the Patient Orders window.

1. Right-click the patient and select **Patient Orders**.
2. Right-click anywhere on a treatment line, and select **Discontinue Treatment**. Repeat if necessary.
3. Click **OK** to save and close the Patient Orders window.

   ![Discontinued treatment appears in light grey text. Right-click and select Restart treatment to add back.]

Discontinued steps can be restarted by following the same steps. Care must be taken when restarting treatments, as any treatments scheduled between discontinuing and restarting will show as overdue.

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Item Description/Units</th>
<th>Billing</th>
<th>Category</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>FLUID/MV Cath/Fluids</td>
<td>1.00/1 line each Daily Care</td>
<td>Continuous</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>R/IM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>R/IM10 of Fr</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>MORP Morphia Inject</td>
<td>1.00/1 line each Daily Care</td>
<td>One time</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>LACSL Laceration rep</td>
<td>1.00/1 line each Treatments</td>
<td>One time</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>WALK Walk (Whitebox)</td>
<td>1.00/1 line each Daily Care</td>
<td>Every 6 hrs</td>
<td></td>
</tr>
</tbody>
</table>

Change Patient Status

When the status of the patient is updated during the patient’s visit, staff are informed and can easily access details about the patient’s visit. When clients call to check on their pets, your staff will have information readily available to provide. Change the patient’s status in the Patient Orders window.

1. In the Electronic Whiteboard window, right-click the patient and select **Patient Orders**.
2. From the **Status** list, select a status.
3. Click **OK**.

   ![Based on practice default settings, staff may receive an alert when invoicing if a patient does not have a ready to go home status.]

   Based on practice default settings, staff may receive an alert when invoicing if a patient does not have a ready to go home status.
Remove Patient from the Whiteboard

On occasion, a patient may need to be removed from the Whiteboard before being invoiced. Most commonly, this happens for a patient that was added to the Whiteboard by mistake.

1. On the Electronic Whiteboard window, right-click the patient’s name and select Remove from Whiteboard. OR On the Patient Orders window, on the far right side, click the Remove from Whiteboard button.
2. Accept the existing status or select a new status for the patient from the Status list.
3. When prompted that the patient will be removed from the Whiteboard, click Yes to continue. The patient no longer appears on the Whiteboard.
4. Close the Whiteboard window.

Completed treatments and charges are not affected when you manually remove a patient from the Whiteboard.

Hide Completed and Discontinued Treatments

Use the Hide discontinued and/or the Hide completed check boxes to hide the completed and discontinued treatments on the Patient Orders and Patient Treatments windows.

Chapter Summary

You learned these important concepts in this chapter:

- **Patient Check-in**—Learn how to add patients to the Electronic Whiteboard window.
- **Create and Finalize Estimates**—Learn how to create and finalize estimates.
- **Electronic Whiteboard**—Learn about the features and benefits of the Electronic Whiteboard window, including the basic Whiteboard work flow, and how the Whiteboard fits into the equation of automating charges.
- **Patient Orders and Whiteboard Patient Visit List**—Learn how to enter patient orders by adding invoice items and smart groups and by transferring charges from the Whiteboard patient visit list.
- **Diagnostic Test Results**—Decide if you want to use the Electronic Whiteboard for handling diagnostic requests.
- **Patient Treatments**—View and navigate the main Electronic Whiteboard window. Perform other tasks such as updating patient orders and viewing a Patient Treatment Report, viewing detailed patient treatment information, entering vital signs and completing treatments, and discontinuing treatments and removing them from the Whiteboard.
**Electronic Whiteboard Reports**

You’ll learn this important concept in this chapter:

- **Electronic Whiteboard Reports**—Understand the types of reports that can be run for the Electronic Whiteboard.

Select **Reports > Patient** on the menu to access the Whiteboard Patient Orders Report and the Patient Treatment Report. You can also view the Patient Treatment Report by right-clicking in the Patient column on the Whiteboard—[Day, Date] window and selecting **View/Print Selected Day** or **View/Print Prior 24 hours**.

**Whiteboard Patient Orders Report**

The Whiteboard Patient Orders Report allows you to print patient Whiteboard orders for the following:

- Selected date or date ranges
- Patient ID
- Attending Doctor ID
- Changed Staff ID
- Current Doctor ID
- Date)

Because the report can be limited by date range, staff can print various lists:

- Patient’s previous treatment orders.
- Treatment orders for the day for the current care doctor.
- Treatment orders for the day for the supervising doctor.

**Patient Treatment Report**

The menu options allow staff to view or print a Patient Treatment Report for a selected day or date range, or (for patients currently listed on the Whiteboard only) for the previous 24 hours.

The report includes:

- List of treatments for each patient
- Treatment status (scheduled, completed, not performed)
- Who completed or did not perform treatment
- Time treatment is scheduled or was performed
- Column in which to handwrite comments and notes

The report is sorted by patient, date, and hour.
To run a report of scheduled treatments from the Electronic Whiteboard window:

1. On the Whiteboard window:
   - To view or print the report for an individual patient, right-click the patient and select **View/Print Selected Day** or **View/Print Prior 24 Hours**.
   - OR
   - To view or print the report for all patients, right-click below the list of patients, and select **View/Print Selected Day** or **View/Print Prior 24 Hours**.

2. Click **Preview**. You can view the information, print the report, or save the information to a file.

<table>
<thead>
<tr>
<th>Treatment (Item ID)</th>
<th>Staff Classification</th>
<th>Area</th>
<th>Category</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>4155 PRE-SURGICAL LABWORK (4155)</td>
<td>Technician</td>
<td>Diagnostics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4155 PRE-SURGICAL LABWORK (x 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4155 PRE-SURGICAL LABWORK</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Print Selected Day option showing patient treatment status for the selected day**

**Chapter Summary**

You learned this important concept in this chapter:

- **Electronic Whiteboard Reports**—Understand the types of reports that can be run for the Electronic Whiteboard.
Travel Sheets

Create custom travel sheets of frequently used products and services used in your practice. You can use the travel sheet on your computer or print copies.

When you install your software, Cornerstone automatically creates a Sample Travel Sheet with the top 150 invoice items from the last 12 months to help you get started. You cannot make changes to the Sample Travel Sheet; however, you can save the travel sheet with a different name and make changes to the new travel sheet.

To add or edit a travel sheet:

1. On the Lists menu, select Travel Sheets.
2. Click New to add a new travel sheet or double-click an existing travel sheet to update it. The Travel Sheet Setup window opens.
3. In the Enter description for travel sheet box, type a description.
4. Click Setup to build your travel sheet. The Build Travel Sheets window opens.

5. In the Invoice Item Information area and Type area, use the drop-down lists and check boxes to filter the item IDs list for quick selection from a narrowed list of items.
6. In the Item ID list, select the items to add to the travel sheet(s).
   - To select all item IDs in the list, click Select All.
   - To select more than one item, press and hold the CTRL key while you click to select each item.
   - To select a range of consecutive items, click the first item and then press and hold the SHIFT key while you click the last item in the range.
7. In the Travel Sheet Description list, select the travel sheets to which you want to add the selected products and services and click Add.
   - To select more than one travel sheet, press and hold the CTRL key while you click to select each sheet.
   - To select a range of consecutive travel sheets, click the first sheet and then press and hold the SHIFT key while you click the last sheet in the range.
8. Repeat steps 5–7 until you have added all items.

9. To remove an item from a travel sheet, select the item in the Item ID list, select the applicable travel sheet or sheets in the Travel Sheet Description list, and click Remove.

10. To see a list of all items selected for an individual travel sheet, click View. On the View Travel Sheet window, select a travel sheet and scroll through the list to view the items. Click Close when finished.

11. When finished building your travel sheet, click OK to close the Build Travel Sheets window and to close the Travel Sheet Setup window. Then, click Close on the Travel Sheet List window.

To arrange the order of the classifications on your travel sheet:

You cannot change the order of the items on your travel sheet, but you can change the order of the classifications by which items are grouped.

1. On the Lists menu, select Travel Sheets.

2. Select the travel sheet to change and click Update.

3. Click Order. The Travel Sheet Classification Order window opens.

4. Select a classification and then use the up and down arrow buttons to move the classification into a different order on your travel sheet.

5. Continue to move classifications using the arrow buttons.
Creating Smart Groups

Smart groups may help your practice to become more efficient when entering routine procedures on invoices, estimates, or patient visit lists. Using the invoice items you have chosen to comprise your patient monitoring group, create the group and make it smart where needed.

Procedural Steps Summary

1. On the menu, select Lists > Invoice Item.
2. Click New to open the Invoice Item Information window.
3. In the ID box, press TAB to accept the item ID provided or type an ID and press TAB.
4. Select Group for the item type.
5. On the Info tab, in the Hospital description box, type a description for the hospital. This appears on the Invoice Item List window, in reports, and in the patient’s medical file.
6. Optional: In the Client description box, type a description for the client.
7. In the Classification area, select the primary classification for the item from the drop-down list. You can also select a subclassification, but it is not required.
8. In the Default revenue center box, type the default revenue center to use for the item. Double-click or press F2 to select the revenue center.
9. In the Status field, leave the status as Active (this is the default status).
10. Optional: If appropriate, select the Miscellaneous item check box.
11. Click the Group Items tab.
12. Add invoice items to the group. Double-click or press F2 to search the Invoice Item List, if needed. You can add inventory items, service items, group items, pick items, and dispensing items to a group item.
13. On an item’s line, click the button in the Smart? column to make the item “smart.” (The button is initially labeled No.) The Smart Code Item window opens.
14. If this item is specific to a species, select the appropriate species in the Species area. To select multiple species, press and hold the CTRL key while selecting each species.
   † You must either select all species rows or no more than four individual species.
15. If this item is specific to a sex, select the appropriate sex in the Sex area. You must select all sexes or no more than two individual sexes. Press and hold the CTRL key while selecting each sex.
16. If this item should only be applied only when the patient is within a certain age range, select the Only pets with ages check box and enter the appropriate age ranges.
17. If this item should be applied only when the patient’s weight is within a certain range, select the Only pets with weights check box and enter the appropriate weight range. Consider weights that are between whole numbers (e.g., 40.1-40.9 pounds).
18. To prompt for a weight entry if it is not on file, select either the Ask for weight check box or the Ask for weight if none was recorded in last 30 days check box.
19. Select the Ask user before adding this item check box if this item is not a routine part of the procedure. This selection would cause a prompt to appear before this item is added to the estimate, patient visit list, or invoice. The prompt would allow you to select Yes or No to add the item.
20. Select the Stop and ask for quantity check box if the item requires a quantity greater than one. This feature is helpful for items such as pharmaceuticals or those that are based on time increments (e.g., Comb Out item).
21. The Group item pricing area allows you to change the pricing structure when these items are applied as part of a group. If you select Mark Up or Mark Down, you can then select whether the price should be adjusted by a certain percentage or amount and then enter the appropriate value.
   † Click the Dollar Sign button to view how the price change is calculated.
22. Select the **Ignore Minimum Price** check box if the price adjustment should disregard the minimum price.
23. Click **OK** to save the smart settings.
24. Complete steps 13-23 to establish smart settings for other items.
25. Click the **Travel** tab.
26. Select any travel sheets on which this item should be listed. Multiple travel sheets may be selected.
27. When the information regarding the setup of this service item is complete, click **OK** to save. The invoice item has been set up and appears in the Invoice Item List.
28. Click **Close** to exit.
Electronic Whiteboard Setup and Usage
Quick Reference Guide

Electronic Whiteboard Setup

The setup portion of this document provides best practice setup tips that help you:

- Customize Alerts
- Customize Areas
- Add New Categories
- Add New Frequencies
- Add New Patient Hospital Statuses
- Customize Wards/Locations
- Create Secondary Reasons for Visit
- Create Electronic Whiteboard Invoice Items

Customize Alerts

Use Electronic Whiteboard alerts to ensure your staff is aware of important information regarding your patients. Patient prompts and patient classifications can be set as Whiteboard alerts. You can also create or manually add Whiteboard alerts on the fly.

- Review patient user-defined prompts and set appropriate prompts as alerts. Prompt color can be also be modified and will show on the Whiteboard.
- Review patient classifications and set appropriate classifications as alerts.
- Create Whiteboard alerts.

Examples:
- DNR
- NPO
- Isolation Protocol
- Nurse’s Name

Customize Areas

Areas can be used as a secondary function of wards/locations as below. The Electronic Whiteboard can be filtered by area. An area can be assigned to each line item on the Patient Orders window (optional).

- Use as service/treatment types to quickly view the Whiteboard for specific task lists.
  - Labs
  - Exams
  - Rads

- Use as staff responsibility list to quickly view tasks by staff:
  - Doctor
  - Technician
Use as a location or department in hospital.
Exampes:
- [ ] Treatment
- [ ] Isolation
- [ ] Boarding

**Add New Categories**

The Electronic Whiteboard comes with categories already set up. Common categories we have seen added are:

- [ ] Bathing
- [ ] Grooming
- [ ] Fluids

**Add New Frequencies**

The Electronic Whiteboard comes with frequencies already set up. Frequencies can be set to recur every day or every x number of days. After working with our clients, we’ve discovered there are some frequencies that could be added to enhance the functionality:

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Example Treatment</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ] SID PM</td>
<td>Medications, feeding, etc.</td>
</tr>
<tr>
<td>[ ] Every 2 hours (even)</td>
<td>Diagnostic testing to be completed starting on even hours</td>
</tr>
<tr>
<td>[ ] Every 2 hours (odd)</td>
<td>Diagnostic testing to be completed starting on odd hours</td>
</tr>
<tr>
<td>[ ] Hourly</td>
<td>Monitoring critical patient and able to receive overdue notices if a treatment is missed.</td>
</tr>
<tr>
<td>[ ] Every 2 days</td>
<td>Medication every other day</td>
</tr>
</tbody>
</table>

It has also been useful to include the times in the frequency description (e.g., SID 8a, BID 7a, 5p)

**Add New Patient Hospital Statuses**

To alert staff of the status of hospitalized patients, consider creating new patient hospital statuses to meet your needs. The patient hospital status can be updated throughout the patient’s stay in your practice.

\[ Additional statuses will be treated as “ready to go home” if the following keywords are included in the description: home, ready, discharge, release, or pick. \]

Examples:
- [ ] In Surgery or Under Anesthesia
- [ ] Patient Care Level for Emergency Cases
- [ ] Boarding
- [ ] Boarding/Meds
- [ ] In Recovery or Anesthetic Recovery
- [ ] Doctor to Discharge
- [ ] Needs Discharge Appointment
- [ ] Discharge Appointment Made
Customize Wards/Locations

Wards/locations are used to notify staff where the patient is located in your practice, to filter the main Whiteboard view and to filter Whiteboard reports. Wards/locations can be updated throughout the patient’s stay if necessary. There are two ways wards are generally used.

☐ Specific Areas of Practice—For practices with more than one treatment area or who need to know exactly at which location the patient is staying, specific wards/locations can be created.

Examples:
☐ ICU  ☐ Isolation
☐ Treatment  ☐ Boarding

☐ Departments—General wards are created when practices do not want to specify areas (ICU, isolation, treatment, etc.) of the practice where the patient will stay. These practices want to use the wards/locations to determine if the patient is a hospitalized or boarding patient.

Examples:
☐ Boarding  ☐ Hospital

Create Secondary Reasons for Visit

To avoid staff having to select from a long list of secondary reasons, you may want to set up the predefined list with only the most common secondary reasons and instruct staff to type other secondary reasons as needed.

Examples:
☐ Hit by Car  ☐ Barium Series
☐ TPLO  ☐ Glucose Curve

Create Electronic Whiteboard Invoice Items

☐ Create Electronic Whiteboard invoice item classification.

☐ Create Electronic Whiteboard invoice items. (Refer to your current paper treatment sheet.)

Examples:
☐ Walk  ☐ Check for Vomiting and Diarrhea
☐ Feed (Hospitalized Patient)  ☐ Take Radiograph
☐ Water  ☐ Check Incision
☐ TPR Monitoring  ☐ Call Owner—Status Update
☐ Monitor Appetite and Drinking  ☐ Blood Draw
☐ Monitor Fluids/Check Catheter  ☐ Remove Catheter
☐ Check Bandage  ☐ Administer Medication

☐ Assign pricing, if applicable; there does not need to be a price associated with these items unless they are billable.

* Nonbillable treatments show on the Whiteboard and not on the invoice.

☐ Set patient order defaults for Electronic Whiteboard invoice items.

* Patient order defaults can be set by modifying a specific item through Lists > Invoice Item > Whiteboard tab or multiple items through Tools > Invoice Item Setup.

☐ Create Whiteboard travel sheet, if applicable.
Create Whiteboard smart groups, if applicable.
Examples:
- Admit Patient Orders
- Inpatient Care

Electronic Whiteboard Usage

The usage portion of this document provides best practice usage tips for:

- Diagnostic Test Requests (IDEXX SmartLink* In-house Laboratory and IDEXX SmartLink* Digital Imaging)
- Patient Orders Tips—Blue Line
- Prescriptions
- Items with Special Pricing
- Patient Order Treatment Schedule

Diagnostic Test Requests

Decisions will need to be made for handling diagnostic requests with the use of the Whiteboard. Ask yourself the following question:

Do I want to see if the diagnostic test has been completed on the Whiteboard?

Prerequisite: Invoice items must have appropriate diagnostic request special actions attached.

| Yes | 1. Finalize estimates and select **Continue** on the Special Action window.  
|     | 2. Enter patient orders.  
|     | 3. Transfer diagnostic items(s) from the Whiteboard Patient Visit List (PVL) to the patient orders.  
|     | 4. Complete patient treatments.  
|     | 5. Click **Process** on the Special Action window to send the diagnostic request to the IDEXX VetLab* Station, Imaging Dashboard window, or to generate the IDEXX LabREXX* test request form and show the diagnostic request as completed.  
|    | **- OR -**  
|    | 1. Finalize estimates and click **Process** on the Special Action window to send the diagnostic request to the IDEXX VetLab Station, Imaging Dashboard, or to generate the IDEXX LabREXX test request form.  
|    | 2. Enter nonbillable patient orders for diagnostic request.  
|    | 3. Use the blue line to note which tests will be run, how much blood to draw, radiograph position, etc.  
|    | 4. Complete patient treatments.  

| No | 1. Finalize estimates and click **Process** on the Special Action window to send the diagnostic request to the IDEXX VetLab Station, Imaging Dashboard, or to generate the IDEXX LabREXX test request form.  
|    | 2. The charge will be found on the Patient Visit List and will not need to be transferred to the Whiteboard.  

Patient Orders Tips—Blue Line

Use the blue lines to communicate treatment details to your staff that are not included in the invoice item description. The information entered on the Patient Orders blue line will be saved to the patient’s electronic medical record when your staff completes the treatment.

<table>
<thead>
<tr>
<th>Invoice Item</th>
<th>Example Blue Line Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluid Administration</td>
<td>Fluid Rate: 60 mL/hr for 2 hours</td>
</tr>
<tr>
<td>Eye or Ear Medications (e.g., Ointment)</td>
<td>Right eye, left eye, both eyes</td>
</tr>
<tr>
<td>Boarding—Admin Meds</td>
<td>Amoxicillin 100 mg; 2 tabs BID</td>
</tr>
<tr>
<td>Boarding—Special Diet</td>
<td>Owner brought treats—treat BID</td>
</tr>
<tr>
<td>Radiograph Initial View</td>
<td>VD, Lat Abdomen, Qty: 2</td>
</tr>
</tbody>
</table>

Prescriptions

There are two ways to handle items with dispensing fees on the Whiteboard. Ask yourself these questions:

Do you dose from a prescribed bottle?

1. Create a prescription label for the medication from the Patient Clipboard* or Patient Visit List OR enter the medication in the Patient Orders window to be completed one time. This will bill the medication and create the prescription label (if the prescription label special action is being used) when your staff completes the treatment.
2. Attach the prescription label special action on the invoice item’s Special Actions tab.
3. Enter an order for a nonbillable service to give the medication with a note on the blue line to denote how much medication. Set the frequency to how often the medication should be given.

Do you dose medication as needed from a common vial?

Enter the medication in the Patient Orders window to be administered with the appropriate frequency.Dispensing items should also be created and attached to the appropriate inventory items to ensure your full dispensing fee will not be charged each time you administer the medication. Dispensing items allow the staff a choice on the dispensing fee that will be added to the medication price.

Dispensing Item Examples:

- [ ] Meds To Go Home
- [ ] Meds Admin In Hospital

Dispensing items are created in the invoice item list.

Items with Special Pricing

When transferred from PVL to Whiteboard, items with special pricing will revert to original price upon completion from Whiteboard. This includes:

- [ ] Estimate Markup%
- [ ] Manually changed prices on estimate/PVL
- [ ] Smart groups with markdown/markup

Suggestions until future release:

- [ ] Consider removing estimate markup % from invoice items
- [ ] Leave “special price” items on PVL and add as nonbillable items on the Patient Orders window
Groups must be moved and completed as an entity for special pricing to remain intact (including group header line)

Alternately, adjust groups to not use markdown/markup feature

Always check/update final PVL pricing before posting to invoice (compare to finalized estimate)

**Patient Order Treatment Schedule**

**Vital Signs**

- Used to bring up the Vital Signs window when item completed on Patient Treatments window
- Use blue line to detail specific vitals to be recorded

**PRN**

- Used in addition to frequency
- For treatments to be performed only “as needed”
- Treatments will not list as overdue

**Dose Now**

- Used in addition to frequency
- For treatments to be performed now, then follow regularly scheduled frequency

**Start Date/Times**

- Used in addition to frequency
- Can set specific dates/start times for each treatment in hour and minute increments

**Duration**

- Used in addition to frequency
- Can set specific duration in days/hours for treatments
- Often used in conjunction with the “continuous” frequency
Skill Assessment and Evaluation
Up and Running With the Electronic Whiteboard
Skill Assessment

Practice Name: 
Your Name: 
Completion Date: 

Instructions: After completing your training, please read each of the following skill assessment statements and evaluate your ability to perform each task. Mark only one X for each skill statement.

<table>
<thead>
<tr>
<th></th>
<th>Can Perform</th>
<th>Can Perform but NOT Using</th>
<th>Cannot Perform</th>
<th>Not Applicable</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>I can identify the areas of the Electronic Whiteboard usage windows that affect customization.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>I can set up and customize treatment categories.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td>I can set up and customize treatment areas.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td>I can set up and customize treatment frequencies.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td>I can set up and customize patient hospital statuses.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.</td>
<td>I can set up and customize wards and locations.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.</td>
<td>I can identify and set up potential nonbillable invoice items used specifically for Whiteboard purposes.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.</td>
<td>I can locate and set the Whiteboard defaults.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.</td>
<td>I can create patient orders.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.</td>
<td>I can move orders from the Whiteboard—Patient Visit List to the Patient Orders window.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11.</td>
<td>I can mark patient treatments as complete.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12.</td>
<td>I can add Whiteboard notes to patient treatments.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13.</td>
<td>I can navigate the fields on the main Whiteboard window.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14.</td>
<td>I can change the patient’s status.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15.</td>
<td>I can discontinue a treatment.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16.</td>
<td>I can remove a patient from the Whiteboard.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17.</td>
<td>I can complete vital sign entry from the Whiteboard.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18.</td>
<td>I can print the Whiteboard Patient Treatment and Whiteboard Patient Orders reports.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Results of the Skill Assessment

____ Can Perform
____ Can Perform but not Using
____ Cannot Perform
____ Not Applicable

Please return this Skill Assessment using one of the following methods:
Return this information to:
Cornerstone Education Department at CornerstoneCoach@idexx.com.

Mail this information to:
IDEXX Laboratories
Attn: Cornerstone Education Department/Gina Toman
One IDEXX Drive
Westbrook, Maine 04092
Up and Running With the Electronic Whiteboard Evaluation

We value your opinion! Tell us what you think about the course.

Practice: ____________________________ Date: _______________
Trainer: ____________________________

Feedback received from you regarding the training is vital to our continued improvement.

Course Description
This course is ideal for those who will lead the setup and implementation of the IDEXX Cornerstone Practice Management System’s Electronic Whiteboard in their practice. You’ll learn both Whiteboard setup and how your staff can use the Whiteboard through the following topics:

- Electronic Whiteboard Work Flow
- Basic Setup
- Patient Orders and Whiteboard Patient Visit List
- Patient Treatments

1. How likely would you be to recommend an IDEXX Cornerstone course to a friend or colleague?

   1 Not Likely .............................................................................................................................. Likely 10

   0  1  2  3  4  5  6  7  8  9  10

2. For us to better understand the opinions of our participants, please explain why you selected the rating above?

3. The prerequisites for this course are:
   - The most current version of Cornerstone installed at practice.
   - Basic Cornerstone navigation.
   - Access to set up Cornerstone features, which means security for electronic medical record setup.
   - Basic Cornerstone setup knowledge: invoice items, departing instructions, and prescription instructions.

Indicate which participants were ready for, and met the prerequisites for, this course.

Please select all that apply.

   O Our practice  O All other practices  O Some other practices
4. How was the length of the course?

- [ ] Too short
- [ ] Too long
- [ ] Just right

Additional Comments:

5. Referring to the items listed below, did we meet your expectations:

<table>
<thead>
<tr>
<th>Item</th>
<th>No</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>The course content matched the course description.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The course materials were professional looking.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The course materials provided contained valuable content.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The trainer arrived well prepared and used appropriate examples.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The trainer used effective communication skills.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The trainer answered all of my questions effectively.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>As a result of this course we can expand our use of Cornerstone’s features.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>This course provided a good value for the cost.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Additional Comments:

6. Did you follow along with the participant workbook during the course presentation?

- [ ] Yes—I followed the participant workbook the majority of the time.
- [ ] No—I didn’t use the participant workbook.
- [ ] Sometimes—I used the participant workbook some, but not most, of the time.

If No or Sometimes, why not?

7. What was the most valuable aspect of this course?
8. What suggestions do you have for future revisions of this course?

9. Using the roles listed, count and record how many participants (from your practice) attended some, or all, of this course. If someone holds more than one of these roles, record their primary role only.

<table>
<thead>
<tr>
<th>Primary Roles</th>
<th>Number of participants with this primary role that attended this course</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veterinarian</td>
<td></td>
</tr>
<tr>
<td>Technician or Nurse</td>
<td></td>
</tr>
<tr>
<td>Reception or Client Services</td>
<td></td>
</tr>
<tr>
<td>Office, Practice or Business Manager</td>
<td></td>
</tr>
<tr>
<td>Practice Owner</td>
<td></td>
</tr>
<tr>
<td>Other (List role and record number)</td>
<td></td>
</tr>
<tr>
<td>Other (List role and record number)</td>
<td></td>
</tr>
</tbody>
</table>

Thank you! We appreciate your feedback.

Testimonial Permission:  
(Please check the box below)

☐ Please have an IDEXX Computer Systems Representative contact me to discuss featuring my comments in promotional materials.

Please Print:

Your Name: ____________________________________________
Practice Name: ________________________________________
Practice City, State: ____________________________
Practice Telephone #: __________________________________

Reminder: Please return this Evaluation using one of the following methods:

Return this information to:
Cornerstone Education Department at CornerstoneCoach@idexx.com.

Mail this information to:
IDEXX Laboratories
Attn: Cornerstone Education Department/Gina Toman
One IDEXX Drive
Westbrook, Maine 04092